The processes and all the routines contained herein are the proprietary properties and trade secrets of SirsiDynix. Except as provided by license agreement, this manual shall not be duplicated, used or disclosed for any purpose or reason, in whole or in part, without the express written consent of SirsiDynix. The information in this document is subject to change without notice and should not be construed as a commitment by SirsiDynix.

SirsiDynix grants the right of copying the enclosed material solely for the internal business use of the end user if (1) this document has been obtained by purchase or by license agreement in conjunction with SirsiDynix products, and (2) this copyright statement is included with each copy. All other copying or distribution is strictly prohibited.

Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in sub-paragraph (b)(3) of the Rights in Technical Data and Computer Software clause in DFARS 252.227-7013.

Rights for non-DOD U.S. Government departments and Agencies are as set forth in FAR 52.227-19(c)(1,2).

Sirsi®, WebCat®, Vizion®, WorkFlows®, Unicorn®, UnicornECOLE®, UnicornOASIS®, UnicornSTILAS®, Site Source®, DRA®, DRA Net®, Inlex®, MultiLIS®, Taos®, JurisLink™, Corinthian®, Dynix®, URSA®, Horizon™, Remote Patron Authentication™, and TeleCirc™ are trademarks of SirsiDynix.

Other product and company names herein may be the trademarks of their respective owners. All titles, versions, trademarks, claims of compatibility, etc., of hardware and software products mentioned herein are the sole property and responsibility of the respective vendors. SirsiDynix makes no endorsement of any particular product for any purpose, nor claims responsibility for its operation and accuracy.
# Table of Contents

**Introduction** .................................................................................................................. 1

Wizards and Helpers .............................................................................................................. 2

Using This Training Guide .................................................................................................... 3

Help Files ............................................................................................................................... 4

Searching Basics .................................................................................................................... 5

**WorkFlows** ..................................................................................................................... 9

Terms to Know ....................................................................................................................... 10

Bibliographic Record Structure ............................................................................................ 14

Log On to WorkFlows ........................................................................................................... 16

WorkFlows Window .............................................................................................................. 17

Toolbars .................................................................................................................................. 18

Delivered Versus Custom Toolbars ...................................................................................... 18

**Menu Bar** ......................................................................................................................... 19

Changing the Desktop ........................................................................................................... 22

**Keyboard Shortcuts** .......................................................................................................... 24

Alt + Underlined Character ................................................................................................. 24

TAB or SHIFT + TAB ............................................................................................................. 24

RETURN Key ........................................................................................................................... 25

Moving From Tab to Tab ....................................................................................................... 25

CTRL + F6 ............................................................................................................................. 26

Function Keys ....................................................................................................................... 26

**Wizard Properties** .......................................................................................................... 27

Wizard Properties Tabs ....................................................................................................... 27

**WorkFlows Help File** ....................................................................................................... 34

Accessing Help ...................................................................................................................... 34

Inside the Help File .............................................................................................................. 35
Balloon Help.................................................................................................................. 39
Workflows Documentation.............................................................................................. 40
Item Search and Display Wizard..................................................................................... 41
Detailed Display ............................................................................................................ 43
Search Types ................................................................................................................ 46
Item Search and Display Helpers .................................................................................. 47
User Searching.............................................................................................................. 50
Searching Techniques .................................................................................................. 52
Check Item Status Wizard ............................................................................................ 54
Search Strategies ......................................................................................................... 55
Boolean Operators ....................................................................................................... 55
AND.............................................................................................................................. 55
NOT.............................................................................................................................. 55
OR................................................................................................................................. 56
XOR............................................................................................................................... 56
Proximity Operators .................................................................................................... 57
SAME.......................................................................................................................... 57
WITH.......................................................................................................................... 57
NEAR........................................................................................................................... 57
ADJ............................................................................................................................... 57
Advanced Searching...................................................................................................... 58
Relational Operators .................................................................................................... 58
Operator Precedence .................................................................................................... 58
Operators as Part of Search Term.................................................................................. 58
Precise Phrase Searching ............................................................................................. 59
Nesting Search Expressions ........................................................................................ 59
Searching Keyword Index Synonyms .......................................................................... 59
Searching Specific Fields ............................................................................................ 60
Stopwords .................................................................................................................... 62
Substitution and Truncation ......................................................................................... 62
Searching Numbers in a List .................................................................................................................. 63
Searching Special Characters .............................................................................................................. 63
Transliterated Characters .................................................................................................................... 63
Punctuation ........................................................................................................................................ 64
Periods ............................................................................................................................................... 64
Miscellaneous Symbols ..................................................................................................................... 65
Introduction

The Essential Skills training guide provides the knowledge necessary to navigate WorkFlows and search for items using different operators and strategies. The Essential Skills course is a prerequisite for all other SirsiDynix Symphony classes.

The Essential Skills training guide comprises two chapters. Below is a short summary of each chapter:

- **WorkFlows.** Introduces terms to know in the software, the staff client interface, keyboard shortcuts, the help file, and how to search for items in the catalog and users in the database.

- **Search Strategies.** Discusses the different strategies that can be used in WorkFlows to identify library materials in the catalog.

This introduction section provides brief information on using the SirsiDynix Symphony Workflows. It begins with an orientation of the screen layout and shows how to navigate within Workflows interface. When logged into SirsiDynix Symphony Workflows, a screen like this displays:
• Module Toolbar. Displays a series of wizards available in the selected module. Only modules relevant to your job may display. Move between modules by clicking on the module toolbar.

• Menu Bar. Can be used to access basic Windows commands, access SirsiDynix Symphony commands, set preferences, and access help.

• Wizard Groups. Organizes wizards into grouped sets that perform related workflows. The arrow in the upper right-hand corner opens or closes the group. Double click on a wizard to open it on the workspace.

• Workspace. Displays the wizards that have been opened. If your Workflow has preference settings that allow multiple windows, windows open one on the top of another so you can have many wizards open at once, moving freely between them.

Wizards and Helpers

Wizards and Helpers are tools used to conduct work within SirsiDynix Symphony. Wizards are labeled icons—the icon visually represents what the tool does, and the label describes the tool’s function. A Helper displays a balloon tooltip when you hover over the icon.

Each entry in a Wizard Group is a wizard. A Helper displays at the top of a workspace in a Helper bar. (A Helper has the same name and label as its equivalent wizard). A Helper is a Wizard that has conveniently been placed inside of a wizard so that related workflows can be addressed from a single reference point.
For example: The Discharging wizard is the tool you would use when performing Checkin-related workflows. A User Registration wizard or Helper is the tool you would use to create a new user in the system.

A library administrator has the ability to organize toolbars and change the labels of wizards. This customization of the SirsiDynix Symphony user interface lets you organize SirsiDynix Symphony for specific groups of people or those performing a specific job function.

**Using This Training Guide**

This guide has been designed for use during a SirsiDynix training. It also has been designed to be used as a reference work for the class. Icons are used throughout the manual for different purposes. The purpose of each icon is described below.

- This icon denotes additional helpful information.
- This icon is a warning. Pay special attention to this information!
- This icon indicates reference information available in another manual or to another chapter within this manual.
Help Files

The SirsiDynix Symphony system comes with an extensive set of online Help files. Every toolbar in your SirsiDynix Symphony system has a Help icon (a purple book with a yellow question mark on it). You can access Help files through the toolbar icon, from the Help option on the menu bar, or by pressing the F1 key when within SirsiDynix Symphony.

Help files are organized either as context sensitive to the screen presently displaying, or topically through a table of contents:

The Help File screen has been divided into three parts for explanation:

- Icons are available to move forwards and backwards through the Help topics, to print, to access an index, and to search.
- Information is organized topically in the left-hand window. Click on a plus sign (+) to open a folder; click on a minus sign (-) to close it.
- The Help file is presented in the right-hand window. The information in the Help file assists in understanding more about software functionality and how to perform relevant workflows.

When you need help with a task, consult the online Help Files first. Your online Help Files are a comprehensive information set of SirsiDynix Symphony WorkFlows.
Searching Basics

Searching for records within the SirsiDynix Symphony client is straightforward. In each case you are searching the database for records—once your desired records are retrieved, they display in the current workflow.

When using SirsiDynix Training Guides, specific tasks will instruct you to “search for a record,” or, “perform a search and select a record.” This section reviews the basics of searching for and selecting records in SirsiDynix Symphony.

To search for a user record:

1. Open the Checkout wizard.

2. Click on the User Search helper at the top of the Checkout window. A user search pop-up like this one displays:

   ![User Search Pop-up]

The User Search and Item Search helpers are highlighted at the top of the window. Within the Search window there are functions to specialize a search by Index, Boolean operators, Library, or Type.

3. Enter a search term, refining it with any of the special search functions, and click Search.
The system displays the results of your search. When there are multiple matches to your search, they display as a list in the lower part of the window:

![Image of the system interface]

Notice that the most recently accessed (Current) borrower displays by default. The names that matched your search entry display in list form.

4. Select the desired user and click **Checkout to User**.

**To search for an item record:**

1. Click on the **Discharge (Checkin)** wizard.

2. Click on the **Item Search** helper. An Item Search window displays:
3. Enter a search term, refining it with any of the special search functions, and click **Search**. Within the Search window there are options to specialize a search by Index, Library, or Type.

Your search results display:

Hit list items display in the upper window, while detail bibliographic, call number, and item information display in the lower window.
4. Select the desired item and click **Discharge Item** to check the book back in. The system automatically directs you if there is any special information about the item such as holds or transits.
WorkFlows

WorkFlows is SirsiDynix Symphony’s staff interface, providing a single graphical client encompassing all areas of library operations.

The WorkFlows client features toolbars that contain icon-based wizards, which are used to perform common library tasks quickly and efficiently. These wizards provide step-by-step guidance through each task, eliminating unnecessary steps, and providing easy access to related tasks.

In this section, you will learn to:

- Understand WorkFlows terminology.
- Understand the bibliographic record structure.
- Log into WorkFlows.
- Understand options within the WorkFlows Menu Bar.
- Change the staff client.
- Use keyboard shortcuts in WorkFlows.
- Understand properties within WorkFlows.
- Use the WorkFlows online Help.
- Use the *Item Search and Display* wizard to search for items in your catalog.
- Use the *Check Item Status* wizard.
Terms to Know

**Bill**

When an item is overdue and is returned, the overdue fine becomes a bill that can be paid. Bills can also be created for damaged materials, lost items, photocopies, etc.

**e-Library**

An Internet access portal for library users developed by SirsiDynix to search for information contained in libraries and on the World Wide Web. It was designed to help library users personalize Web searches and find related information on the Internet. Patrons use e-Library to access their personal accounts.

**Fine**

Fines accrue on overdue materials until the materials are discharged and a bill is automatically created. Fines cannot be paid...bills are paid.

**Gadget**

A gadget is a button next to a text box that provides options you can use in a particular box. When you click the gadget, a window appears giving you a list of predefined values, calendars, etc. Always click the gadget (if one is available) to make sure you enter the correct information in the correct format.
Glossary

This term refers to any text or character in WorkFlows that appears with a dashed underline. When you click this text or character, a popup window appears with additional information. For example, if you click Alerts, the following information appears:

Helper Bar

The Helper bar is positioned horizontally across the top of the WorkFlows client interface, just below the active window’s title bar. Helpers listed on the left side of the bar primarily make it easier to access necessary information needed by the current wizard. For example, the Checkout wizard can use the following helpers: User Search, Display User, Register New User, User Lost Card, Renew Privilege, Confirm Address, Pay Bills, Add Brief Title, Item Search, Change Item ID, Special Due Date, and Print User. For more information about helpers, search the specific helper topic. Helpers have context-sensitive links to help topics.

Hold

A hold may be placed by one patron on items that are checked out to another patron. Some libraries also allow holds to be placed on items that are currently on the shelf.
OPAC

OPAC is an acronym for Online Public Access Catalog. Patrons access library holdings using e-Library, which is an OPAC.

Request

The Request module is an optional SirsiDynix Symphony module that lets patrons communicate with staff member using request forms through the OPAC. Requests are answered through WorkFlows.

SirsiDynix Symphony

The integrated library system (ILS) software on the server that coordinates services for staff and public use.

Toolbox

A toolbox will appear in the upper left corner of some wizard tabs. The toolbox will contain tools that will assist you in creating, modifying, duplicating, or removing tab information. For example, the Segments tab in acquisition wizards will display the Add a Funding/Distribution Cluster(s), Add an Additional Split, Add a Claim, and Add a Cancellation tool among others in the tab toolbox. Change an Issue, and Remove Claim(s) tools in the tab toolbox.

ToolTips

A ToolTip is brief definition that appears when you move the cursor over a wizard. This is also called Balloon Help.
Wizard

A wizard is a button on a toolbar that guides you through the steps to accomplish a task. When you move the cursor over the wizard, the name appears, and a description of the wizard displays in the status bar.

Wizard properties let you customize how wizards work. Each time you right-click a wizard, you can change the properties. Library staff can save changes to individual workstations; system administrators can save changes to the server.

WorkFlows

The staff client installed on staff PCs that connects to the SirsiDynix Symphony server that is used for searching, cataloging, circulation, and other staff activities.

Z39.50

Z39.50, an American National Standard Information Retrieval Protocol, provides a standard language for computer-to-computer information retrieval. Patrons can use Z39.50 through their OPAC to access other library catalogs and retrieve bibliographic information.
Bibliographic Record Structure

SirsiDynix Symphony catalog records include the following types of information:

- **Title or Catalog**
  - Fixed Fields
  - Bibliographic Data
    - (Title Author, Subject)

- **Call Number or Volume**
  - Call Number
  - Class Scheme
  - Library

- **Item**
  - Item ID/Barcode
  - Item Type
  - Location
  - Price

- **Call Number or Volume**
  - Call Number
  - Class Scheme
  - Library

- **Item**
  - Item ID/Barcode
  - Item Type
  - Location
  - Price
### Essential Skills

**Control Bibliographic**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Schooling children with Down syndrome: toward an understanding of possibility. Foreword by Douglas Birkett.</td>
</tr>
<tr>
<td>Physical Description</td>
<td>167 p. (1 fig.)</td>
</tr>
<tr>
<td>Series</td>
<td>Special education series</td>
</tr>
<tr>
<td>Bibliography Note</td>
<td>Includes bibliographical references (p. 141-156) and index.</td>
</tr>
<tr>
<td>Subject Term</td>
<td>Children with mental disabilities \ Education \ Social aspects \ United States.</td>
</tr>
</tbody>
</table>

**Call Number level**

- **Call number:** LC4631 . J35 1998
- **Class scheme:** LC
- **Call library:** FEW

**Item Information**

- **Item ID:** 31870003999063
- **Copy number:** 1
- **Type:** BOOK
- **Home Location:** STACKS
- **Media disk:** Number of pieces: 1
- **Total charges:** $35.87

The Call Number level contains the call number, class scheme, and the library that owns the copies.

The Title/Catalog level contains the bibliographic information, fixed fields and control information such as when the record was created/cataloged.
Log On to WorkFlows

WorkFlows is SirsiDynix Symphony’s staff interface, providing a single graphical client encompassing all areas of library operations.

To log in:

1. Double-click the icon to launch WorkFlows.

2. Click OK.
3. Type your User ID and PIN, and click OK.

The display a user sees in Workflows is configurable by a system administrator. The screen options that display and the functionality available to you may vary from these examples.

During the log on process, configuration files download from the host machine to the workstation. The system “pushes” files from the host machine to each workstation. This ensures that configuration changes made on the host machine are delivered to each workstation.

**WorkFlows Window**

The WorkFlows client features toolbars that contain icon-based wizards, which are used to perform common library tasks quickly and efficiently. These wizards provide step-by-step guidance through each task, eliminating unnecessary steps, and providing easy access to related tasks.
Toolbars

The Module Toolbar across the top of the WorkFlows window changes the Wizard toolbar that appears on the left side of the window.

A wizard toolbar is a collection of individual wizards or wizard groups. By default, each module in WorkFlows has its own toolbar, but it is possible to customize toolbars to meet specific library needs.

Delivered Versus Custom Toolbars

SirsiDynix Symphony is delivered to you with a standard set of toolbars. A library administrator can change these toolbars to suit the needs of the library and even departmental preferences within the library.

For example, the Discharging wizard on the left is changed to “Check In.”

An administrator can rename wizards, remove or add wizards, and reorder wizards from a toolbar. The administrator can also create custom toolbars for specific job responsibilities within the library — so that only those tools applicable to the job display to library staff. Reorganizing toolbars might include creating an entirely new toolbar and combining wizards originally on different delivered toolbars onto the new toolbar, as shown below:
**Menu Bar**

The menu bar lets you access basic Windows and WorkFlows commands. For complete information about the options on the menu bar, see the WorkFlows online Help file.

**File** – Use the File menu to preview and print the current client window, update the staff client, and exit WorkFlows.

**Edit** – Use the Edit menu to cut, copy, or paste selected text in the current window.

**Wizards** – Use the Wizard menu to select wizards on the current toolbar using keyboard commands (as described earlier).

**Preference** - Use the Preference menu options to change the display and functionality of individual workstations. There are a few options within the Preference menu:
• Configuration – Click this to display the Configuration window.

![Configuration Window]

- **Host information**
  - IP Address: localhost
  - Port: 5100

- **Workstation**
  - Name: PCGUI-DISP
  - Login timeout: 60000 Seconds

- **Show this window on next startup**

  ![OK Cancel Buttons]

• Peripherals – Here you can set options for receipt printers, barcode readers, and barcode configuration.

• Desktop – Selects a toolbar and specifies window options.

![Desktop Menu Options]

Below are the **Desktop** menu options:

• Font Settings – Customizes the workstation font.

![Font Settings Window]

- **Menu text**
  - **Use system defaults**
  - Customize font: 24 Verdana Bold

- **Window text**
  - **Use system defaults**
  - Customize font: 16 Verdana Bold

  ![OK Cancel Buttons]
- Current Toolbar – Allows you to select a different toolbar (Select), save a customized toolbar to your workstation (Save As), assign function keys to various wizards (Function Key Mapping), modify a delivered toolbar (Toolbar Management), and change the language of the interface (Localization).

Tools – Use the Tools menu to insert special characters and diacritics.

<table>
<thead>
<tr>
<th>Tools</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol Table...</td>
<td>Loaded Character Sets...</td>
<td></td>
</tr>
</tbody>
</table>

Window – Use the Window menu to arrange windows for display.

<table>
<thead>
<tr>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tile</td>
<td></td>
</tr>
<tr>
<td>Cascade</td>
<td></td>
</tr>
<tr>
<td>Horizontal</td>
<td></td>
</tr>
<tr>
<td>Vertical</td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td></td>
</tr>
</tbody>
</table>

This menu option will only display if the Multiple windows mode is selected in Desktop Setup of the Preference menu.

Help – Use the Help menu to display the WorkFlows Help files.

For further information about the Help file, refer to page 34.
Changing the Desktop

WorkFlows has two desktop views: Classic WorkFlows and Themes. The Themes interface helps you navigate quickly between SirsiDynix Symphony modules. It also lets you choose from several color palettes, giving you a different user interface display as described below:

To change desktop settings:

1. On the menu bar, click **Preference – Desktop – Desktop Setup**.

2. You can change any of these settings:
   - Default Help Topic. This help topic will be the first to display when you click the Help button. If you do not select a default help topic, the main help topic WorkFlows Online Help will display.
   - Proxy Server Configured. Select this option if a proxy server is in use. This allows help files to display through the proxy server. Once this option is selected, you will be prompted to enter the host domain and port number of the proxy server.
   - Opening Wizard. This wizard will be the first to display upon client startup. The default is None.
   - Max Response Size. The Maximum Response Size field is used to specify how many characters are returned from the server before truncating the information retrieved.
- Display Date Format. Specifies the format of dates displayed on the system.
- 24 Hour Clock Format. Converts display format to a 24-hour clock.
- Default Toolbar. The selected toolbar is used only if you switch servers, and the most recent toolbar you used in the previous session (usually a custom toolbar) is not available on the server.
- Themes. Designates the theme (color scheme) that displays.
- Multiple Windows Mode. This allows you to permit multiple wizard windows to be open at one time. In Workflows Themes mode, only one window is open at a time, by default. When this checkbox is selected, you will not see the Window menu option until you have exited Workflows and started a new session.

3. In the Themes box, select the color scheme you want to use for your Desktop, and click OK.

For further information about the Workflows desktop, see the topic “Preference Menu” in the Workflows online Help files.
Keyboard Shortcuts

Navigating through Workflows windows and using Workflows functions can be accomplished using a mouse or the keyboard.

Alt + Underlined Character

Pressing ALT in combination with an underscored number or letter performs the same action as clicking the menu item or button. Note the underlined letters on this menu:

```
Preference   Tools
Configuration...
Peripherals
Desktop
```

And here is an example of underlined letters on buttons:

```
Check Out Item To User  Check Out To New User  Close
```

In this example, pressing ALT+O would check out an item to a user.

TAB or SHIFT + TAB

Press TAB to move forward between writable fields, check boxes, and buttons. Press SHIFT+TAB to move backward between active, input text boxes, check boxes, and buttons.
RETURN Key

In every wizard one of the buttons is designated as the default. Pressing the Enter key will follow through with that designated action (whatever action the button indicates). For example, after filling in the fields to register a new user, simply press Enter to register the user. (The default key in the User Registration wizard is Save.)

Moving From Tab to Tab

Many wizards organize information on a series of tabs. A quick and easy way to move between tabs in a window is to use Shift + Page Up to move left to right through tabs, and Shift + Page Down to move in reverse order through tabs (right to left).
CTRL + F6

Pressing CTRL and F6 toggles between wizards that are currently open. For example, if you have 5 windows open, the CTRL and F6 keys in combination bring a different open window to display with each successive key combination.

Function Keys

Each WorkFlows module (Circulation, Cataloging, etc.) has function keys (F1, F2, etc) or function key combinations (function key plus SHIFT and/or ALT) mapped to certain wizards. You can view a list of these mappings by going to the menu bar and selecting Preference—Desktop—Current Toolbar—Function Key Mapping.
Wizard Properties

Each wizard has properties which provide window defaults and various control settings for each wizard. SirsiDynix provides a set of system properties. When a client session is started, the delivered properties are downloaded to the workstation. Any changes a user makes to properties are saved on that user’s workstation and the changes will be displayed for that user the next time the wizard is used.

To display a wizard’s properties (if it has any), right-click on the wizard.

Wizard Properties Tabs

Wizard properties may contain the following tabs:

- Behavior. On the Behavior tab, you can preset selected field values and select which next steps and/or tabs will display with a specific wizard or helper. Some wizards will contain an At End of Wizard screen area, in which you can select which next step buttons display at the end of the wizard workflow or select which action the wizard should automatically perform as the last step of the wizard.
The example below is a screen shot of the **Behavior** tab of the **Checkout** wizard properties in the Circulation toolbar:

<table>
<thead>
<tr>
<th>Configure</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Hide current user</td>
<td>Hide current Item</td>
</tr>
<tr>
<td></td>
<td>Extend user’s library privilege</td>
<td>Pay bills</td>
</tr>
<tr>
<td></td>
<td>Proxy checkout with cancel hold</td>
<td>Checkout reserve desk items</td>
</tr>
<tr>
<td></td>
<td>Automatically restart checkout on item ID error</td>
<td>Display circulation note</td>
</tr>
<tr>
<td></td>
<td>Cache Item ID’s</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Display current checkouts counter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Automatically renew items already checked out as seen</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Automatically renew items already checked out as unseen</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Do not automatically renew items already checked out</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Checkout all Items associated with a set</strong></td>
<td>Yes Prompt</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User Alerts Display</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Display alert for delinquent user</td>
<td>Display user alerts</td>
</tr>
<tr>
<td></td>
<td>Display alert for previous loan</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sounds</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Play sound for User Delinquent alert</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Play sound for User Blocked alert</td>
<td>block.wav</td>
</tr>
<tr>
<td></td>
<td>Play sound for Item Hold Block alert</td>
<td>holdblock.wav</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Charge printing</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>None</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Print date due slips</td>
<td>Print date due slips</td>
</tr>
<tr>
<td></td>
<td>Print charge receipts</td>
<td>Print charge receipts</td>
</tr>
</tbody>
</table>
Below is the **Behavior** tab for the *Add Title* wizard properties in the Cataloging toolbar:

![Add Title: Set Properties dialog](image)

- **Select Behavior**
  - Add call number
  - Prompt for library when adding a new call number
  - Auto-generate temporary XX call numbers
  - Add item when adding a new call number
  - Add item
  - Auto-generate item ID when adding item
  - Delete call number
  - Delete item
  - Maintain MARC Holdings
  - ISRN warnings must be acknowledged
  - Disable diacritic keyboard shortcuts
  - Set current location of new items to AVAILABLE_SOON

- **Print labels for new items**
  - Automatically
    - Prompt for label template
  - Print preview
  - Use label template profiles

[OK] [Cancel]
- Defaults. Preset field values and select which information will display with a specific wizard or helper. Default settings are saved at the PC login level, not the WorkFlows login level.

The example below is a screen shot of the **Defaults** tab of the **User Registration** wizard properties in the Circulation toolbar:
The example below is a screen shot of the **Defaults** tab of the *Add Title* wizard properties in the Cataloging toolbar:
• Helpers. Select which helpers will display with a specific wizard or helper. You can configure properties for helpers by clicking on the button under the helper name in wizard properties.

The example below is a screen shot of the **Helpers** tab of the Checkout wizard properties in the Circulation toolbar:
The example below is a screen shot of the **Helpers** tab of the *Add Title* wizard properties in the Cataloging toolbar:

Administrators and supervisor-level staff have access to Behavior, Defaults, and Helpers properties. Other staff has access to Defaults properties only.

If you have made changes to properties and close the workstation, a message will appear:

If you click *Yes*, you save those changes to your workstation (Windows) login, not your WorkFlows login. The changes will be displayed the next time the wizard is used.

For further information about the specific behaviors, defaults, and/or helpers available with each wizard, refer to the context sensitive WorkFlows online Help. Also refer to the help topic “FAQ: Understanding Properties in WorkFlows” for additional properties information.
WorkFlows Help File

The WorkFlows Help file is the primary source of documentation for each SirsiDynix Symphony module. The Help file can give you immediate context-sensitive assistance while you are working in WorkFlows. In addition, it provides numerous FAQs and other information that give you background and in-depth information on specific topics.

The WorkFlows Help file is context-sensitive. This means that the help information that displays is specific to the task you were performing when you accessed the Help file.

Help topics display in a separate window. You can leave the Help window open and toggle between the task window and the Help window when performing procedures. You can also print individual Help topics.

Accessing Help

You can access the Help file several ways:

- Press F1. This opens the context-sensitive Help.
- Right-click any wizard.
- Click on the Help wizard.
- On the Menu bar, click Help and select either Contents or Context.

When accessing the Help file from the menu bar, you have five choices:

- **Contents.** This option opens the Table of Contents for the Help file.
- **Context.** This option opens the context-sensitive Help.
- **Key Enhancements.** This option displays summaries of new features available in this release.
- **Session Info.** This option displays login and host information about the current WorkFlows session.

- **About.** This option displays the software version and the SirsiDynix copyright statement.

In the process of troubleshooting, and in correspondence with SirsiDynix Client Care, it is often necessary to provide detailed information about the client session. This information may be accessed by clicking Session Information on the Help menu. Detailed login information such as the user’s login, user access, environment, profile, and station library are provided. Detailed server information including server IP address, server platform, and server version number are also available.

**Inside the Help File**

Once inside the Help window, you have several ways in which to find the information you are looking for:

- **Navigation Pane**
- **Content Pane**
The tabs on the Navigation pane give you three ways to locate information:

**Contents.** Displays topics alphabetically by module.
Index. Displays an alphabetical list of topics to choose from.
Search. Type a term or terms in the box and the search engine will locate these terms anywhere in the Help file.

The numbers before the topic indicate the number of times that the search query appears in the topic. A list of topics with relevant passages will appear. Circles indicating relevance ranking will appear next to these topic titles, along with the number of times your query was matched in the topic. There are five possible rankings (from highest to lowest): full circle, ¾ full, ½ full, ¼ full, and empty.

The information displays in the Content pane on the right with the search term highlighted within the text.
Balloon Help

Balloon Help displays in a box below the cursor when you hold the mouse over a wizard or group wizard.

Flyby help displays in the status bar simultaneously as the balloon Help displays but only in the Workflows Classic view.
WorkFlows Documentation

WorkFlows Online Help. Search the online help to find out how to use specific SirsiDynix Symphony modules. Module topics, wizard topics, FAQs, and general setup information is provided. In addition, there are also documentation resources available on the SirsiDynix Client Care Web site, clientcare.sirsidynix.com.

SirsiDynix Products. Search these pages for technical information about SirsiDynix products, including Client/Server requirements, Configuration guides, FAQs, Webinar information, and more.

SirsiDynix Symphony Training Guides. These guides are used for the official SirsiDynix Symphony training. These guides are available to you in pdf format at the time of your training, or on the Mentor website.


SirsiDynix Symphony Known Issues. Search these pages for descriptions of known software issues that are in the process of being resolved. Access SirsiDynix Symphony Known Issues from the Products — SirsiDynix Symphony — Known Issues link.
**Item Search and Display Wizard**

Use the Item Search and Display wizard to perform Keyword, Browse, or Exact searches. It displays information at the title, call number, and item level. You can also view circulation, booking, hold, order, and serials information.

**To search for an item in your bibliographic database:**

1. Click the Item Search and Display wizard.

If the Set Properties window appears, verify the defaults and click **OK**.

2. In the Search For box, type the title or other criteria to search.

3. Select Keyword, Browse, or Exact for the type of search you want to perform.

4. In the Index drop-down, select the index you want to search (Title, Subject, Author, etc.).

5. If you are in a multi-library setting, you can qualify the search in the Library drop-down by selecting a single library or all libraries.

6. Click **Search** or press **ENTER**. All item records fitting the criteria you entered will display.

The Item Search and Display results window is divided into three sections (panes) that change depending on the activity you perform.
• Search Pane. Contains the fields needed to perform a search and retains the last search that you performed.

• Hit List Pane. Displays the hit list pane displays all records that qualified on the search. You can expand the size of this pane and each column. You can also reorder the columns by dragging them with the mouse. Resort each list by clicking the Title, Author, or Pub. Year headings.
Viewers Pane. Title, call number, and item level information for the record selected in the hit list pane displays in the viewer pane. Click the plus and minus signs to expand/collapse the call number and item records.

Detailed Display

With the Item Search and Display window open, a Detailed Display button displays. Clicking this button displays additional information on the selected title. (Double-clicking a record in the hit list pane performs the same function.) Detailed Display provides in-depth information about the bibliographic, call number, and item level records.
Depending on the properties set for the Item Search and Display wizard, the following tabs of information may display:

- Description
- Orders Information
- Call Number/Item
- Bills
- Orders
- Checkouts
- Holds
- Bookings
- Holdings
- Serial Control

**Control Tab**

The **Control** tab contains information about the title record, including its control number, date created, and date modified.
Bibliographic Tab

The MARC record information that displays on the Bibliographic tab is common to all volumes and copies of the title, and is used primarily to bibliographically describe the item or items. The Bibliographic tab contains the data that is indexed for keyword searching and browsing.

MARC Holdings Tab

The MARC Holdings tab can contain information about holdings in one or more libraries for a particular title. This information displays in the OPAC.

Call Number/Item Tab

The Call Number/Item tab displays information about individual call numbers and items attached to a bibliographic record. The Call Number/Item tab is subdivided into additional categories of information, which can include item checkouts, circulation, bills, holds, and general information about the item.
Search Types

**Keyword.** Keyword searching returns records that contain the term(s) entered, wherever they may appear in the field(s) specified in the search. Author, General, Periodical Title, Subject, and Title are keyword-searching options that support Boolean and proximity operators, substitution, truncation, and nesting.

**Browsing.** In a Browse search, SirsiDynix Symphony matches terms entered character by character with cataloged entries in the system. The Browse option produces a list in the alphabetic vicinity of the term you typed. The second item in the list—the closest match—will be highlighted, and from that point you can browse forward or backward in the list.
Exactly. If you select Exact, SirsiDynix Symphony searches the browse list, and if it finds an exact match, it displays only the matching record or hit list associated with that entry. If SirsiDynix Symphony does not find an exact match, a browse list appears at the point closest to the search term.

**Item Search and Display Helpers**

Two helpers display on the Item Search and Display window: *Configure Options for Item Search* and *Advanced Search*. These helpers are tools to provide focus and limits on the searches conducted.

**Configure Options for the Item Search**

The *Configure Options for Item Search* helper qualifies the search method selected to conduct the search allowing users to limit their search.

Click this helper to display the following windows:

- **Search** - Limits and sorts a Search lookup method based on volume/copy characteristics.
- **Call Number Browse** - Limits the headings that are retrieved in a call number browse search.

- **Display (Exact)** – Limits and displays search results based on individual item characteristics. Settings in this field govern the display of individual items retrieved from an Exact search or search lookup methods.
WorkFlows retains search, display and call number browse settings until you change them or close the wizard. Leaving the settings in place may disqualify future searches and you may receive the following message:

```
No items found. Change your limit options and search again.
```

**Advanced Search Helper**

The *Advanced Search* helper changes the search options at the top of the Item Search and Display window.

These options allow you to use Boolean operators to refine searching.

*Configuration of the Advanced Search helper must be done by an administrative or supervisor level login.*
**User Searching**

The *User Search* helper is used to identify a user and is helpful when you do not have the User ID. It is found in many of the wizards on the Circulation toolbar.

Various search options are available. You can perform a keyword or browse search. If performing a keyword search, search options may include name, phone, email, user ID, and so on.

**To search for a user:**

1. Click on the *User Search* helper.

2. In the Search For box, type either a name or search criteria.

3. Select a search Type using the drop down and select the Index you want to search.
4. If necessary, use the drop down to select a specific library.

5. Click **Search**. All records fitting the criteria you entered will display in the List of Users.

6. Highlight a user and click the appropriate button to perform the next function with that user’s record.

7. When you are finished viewing the information, click **Close**.
Searching Techniques

When searching for users, you can choose from the following types of searching:

- **Keyword.** Locates and displays user records that contain the terms you entered. Boolean operators, field qualifiers, and other search strategies can be used to narrow or expand your search. The search indexes that display are wizard specific.

- **Browse.** Produces a list in the alphabetic vicinity of the term you entered. For example, a search on Jones J might return all users with a last name of Jones and whose first name begins with J.

- **Browse User Group.** Locates and displays an alphabetic list of user groups. Selecting a user group displays a list of the names and user IDs of the members in the group.

When performing a keyword search:

- In the Search For box, type the text you want to use for the search. You can type or paste up to 200 characters into the Search For field for Keyword user searches.

- You can perform a partial name search for users, but you must use a dollar sign ($) as the truncation symbol. SirsiDynix recommends including as many characters as possible before the truncation symbol so the resulting list of matching records is meaningful and concise. For example, searching for smith, jo$ produces a more concise hit list than searching for smith$ or smith, j$.

- If you do a truncated keyword search for user name, the results may not be sorted as expected, depending on the number of matches found.

<table>
<thead>
<tr>
<th>Name</th>
<th>User ID</th>
<th>Alt ID</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Johnston, Sue</td>
<td>210000182</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Carter, John</td>
<td>CARTERJW</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Johnson, Amber</td>
<td>210009278</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Newell, John</td>
<td>210000058</td>
<td></td>
<td>314-992-0777</td>
</tr>
</tbody>
</table>
• The User ID field is limited to a maximum of 20 alphanumeric characters. You can perform a partial name search for users, but you must use a dollar sign ($) as the truncation symbol.

• You can use multiple search options by using the AND or OR operators. Up to eight search options can be specified for a single user search.
Check Item Status Wizard

Use the Check Item Status wizard to display the status of an item, where
the item is shelved, and whether it should be put in transit.

To check an item's status:

1. Within any toolbar except for the Offline toolbar, click the Check Item
   Status wizard.

2. Scan the barcode, or type the Item ID and click Check Status.

3. Click Check Another Item to see the status of another item, or click
   Close to exit this window.
Boolean Operators

In this training guide, Boolean and proximity operators appear in upper case for clarity within the text. However, when using them as part of a search phrase, case is NOT a determining factor.

Boolean operators (AND, NOT, OR, and XOR) locate records containing matching terms in the library catalog. The following list explains each operator. Operators link search terms and define the relationship between them. Operators also help to focus the search.

**AND**

SirsiDynix Symphony locates records containing all of the specified terms.

For example, a subject search on “cats AND dogs” locates those records that contain information on both cats and dogs. Records about only cats or records about only dogs are excluded.

**NOT**

SirsiDynix Symphony locates records containing all of the specified terms.

For example, a subject search on “cats NOT dogs” locates those records that contain information on cats but not dogs. Records about only dogs are excluded.
SirsiDynix Symphony locates records containing the first search term but not the second.

For example, a subject search on “cats NOT dogs” locates records only about cats, and excludes any records about cats that also contain information about dogs.

**OR**

SirsiDynix Symphony locates records matching any or all of the specified terms.

For example, a subject search on “cats OR dogs” locates records that contain information only about cats, records only about dogs, and records that contain information on both cats and dogs.

**XOR**

SirsiDynix Symphony locates records matching any one of the specified terms but not all of the specified terms.

For example, a subject search on “Freud XOR Jung” locates records only about Freud and only about Jung. Records that contain information on both Freud and Jung are excluded.
**Proximity Operators**

Use proximity operators to connect words or phrases within a single field entry.

**SAME**

SAME locates records in which a bibliographic record field contains all of the specified terms.

For example, *stephen SAME king* displays items by Stephen King, but not a biography of Martin Luther King by Stephen Jones.

SAME is the default proximity operator in SirsiDynix Symphony! (Incidentally, you can also configure your OPAC to use **AND** instead of **SAME** as the default proximity operator.)

**WITH**

WITH locates records in which a field contains a sentence with all of the specified terms. Usually, you would use this operator in a specific database search, such as title, subject, or author.

For example, *chris WITH pat* could display “Chris and Pat go to Summer Camp,” but not “Chris goes to Summer Camp. She meets Pat there.”

**NEAR**

NEAR locates records in which a field contains all search terms adjacent to each other; however, the order of the terms does not have to match the order they were entered.

For example, *rose NEAR red* displays “Snow White and Rose Red” and “My Love is Like a Red Red Rose.”

**ADJ**

ADJ locates records in which a field contains all of the search terms adjacent to each other and in the order they were entered.

For example, ADJ2 means that the words must be within two searchable words of each other, but they must be in the order they were entered. Therefore, search for “English Literature” as English ADJ literature.
Advanced Searching

Relational Operators

Relational operators (<, >, =, <=, >=) let you search a numeric expression, such as a date. Use relational operators by enclosing a field name or entry tag number in braces {}, then typing a relational operator and number.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>less than</td>
</tr>
<tr>
<td>&gt;</td>
<td>greater than</td>
</tr>
<tr>
<td>=</td>
<td>equal to</td>
</tr>
<tr>
<td>&lt;=</td>
<td>less than or equal to</td>
</tr>
<tr>
<td>=&gt;</td>
<td>greater than or equal to</td>
</tr>
</tbody>
</table>

For example, {260}>2009, would search the 260 tag for records with dates after 2009.

Operator Precedence

When the search expression consists of a combination of terms, you can define the order in which these terms are searched. If two operators are at the same level in the list, SirsiDynix Symphony first searches the term at the left, then moves right. Refer to the following list for operator precedence, with the highest listed first.

NEAR, ADJ
WITH
SAME
AND, NOT
XOR, OR

Operators as Part of Search Term

To search for an operator, enclose it in double quotation marks.

For example, death be not proud returns a very large hit list comprised of all titles in the catalog that do not contain the phrase, “Proud.” To prevent this, type death be “not” proud, or enclose the entire phrase in double quotes. (Double quotes treat operators as terms.)
Precise Phrase Searching

To search for terms in the exact order entered, enclose the expression in single quotes. Remember this...“Single quotes; single phrase.” SirsiDynix Symphony will locate items in the catalog exactly as typed in the search field. Single quotes do not process operators as search terms.

In the located records, the matched term(s) must also display in the same (adjacent) order as the order they were entered. However, the search expression can display in any of the heading fields searched using the index selected.

For example, ‘Martin Luther King’ searches only for items that have these words, in this order.

Nesting Search Expressions

SirsiDynix Symphony allows search expressions to be grouped or nested using parentheses. SirsiDynix Symphony searches the expression located in the innermost set of parentheses first. SirsiDynix Symphony continues the search, moving outward to the terms at the edges of the expression.

For example, (movies OR films) AND reviews first locates records containing movies or films. From these records, it selects those records that also contain reviews.

Searching Keyword Index Synonyms

Every record in the SirsiDynix Symphony database has standard entry tags. The most common format is the MARC format with MARC entry tags. SirsiDynix Symphony allows one or more MARC entry tags to be represented with an index synonym name. You can limit the search to certain fields and entries within a bibliographic record without typing several entry tags.

To search the general index, type the search term followed by the keyword index synonym enclosed in braces {}. SirsiDynix Symphony searches only the specified entries/fields represented by this abbreviated name. If you do not specify a synonym name, SirsiDynix Symphony searches all indexed fields within the record.

Refer to the following list of SirsiDynix Symphony equivalent search fields for keyword indexes. These tags are most effective when conducting a General index search.
<table>
<thead>
<tr>
<th>Keyword Index</th>
<th>Synonym</th>
<th>MARC Entries Included</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>TI</td>
<td>130, 245, 246, 440, 730, 740</td>
</tr>
<tr>
<td>Author</td>
<td>AU</td>
<td>100, 110, 111, 700, 710, 711, 720</td>
</tr>
<tr>
<td>Subject</td>
<td>SU</td>
<td>600, 610, 611, 630, 650, 651, 655, 690, 691</td>
</tr>
<tr>
<td>Series</td>
<td>SER</td>
<td>400, 410, 411, 440, 490, 800, 810, 811, 830, 840</td>
</tr>
<tr>
<td>Periodical Title</td>
<td>PER</td>
<td>245, 246, 780, 785</td>
</tr>
</tbody>
</table>

For example, to locate items by Charles Dickens, enter a General search with the following text.

Dickens {AU}

SirsiDynix Symphony locates items by searching all MARC entry fields represented by the keyword index synonym, AU. In this example, SirsiDynix Symphony searches the 100, 110, 111, 700, 710, 711, and 720 entry tags for Dickens.

Searching Specific Fields

Every record in the SirsiDynix Symphony database has a particular format consisting of standard entry tags. SirsiDynix Symphony lets you limit the search to certain fields and entries within a bibliographic record. Using the General search index, enter your search expression followed by the entry tag(s) enclosed in braces { }. SirsiDynix Symphony locates only records with a search term in the specified entries/fields.

Dickens [100]

Any entries may be combined in a single search. In the following example, SirsiDynix Symphony will search the main title (245) entries and the primary (100) personal author entries.

Dickens [100 245]

The following entries are some of the most common MARC and Technical Report entry tags.
<table>
<thead>
<tr>
<th>US MARC ENTRY</th>
<th>Tag Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Personal author main entry</td>
</tr>
<tr>
<td>245</td>
<td>Main title and statements of responsibility</td>
</tr>
<tr>
<td>260</td>
<td>Publication information including date published</td>
</tr>
<tr>
<td>440</td>
<td>Series title entry</td>
</tr>
<tr>
<td>490</td>
<td>Series entry</td>
</tr>
<tr>
<td>500</td>
<td>General note</td>
</tr>
<tr>
<td>505</td>
<td>Contents note</td>
</tr>
<tr>
<td>520</td>
<td>Summary or abstract</td>
</tr>
<tr>
<td>650</td>
<td>Topical subject heading</td>
</tr>
<tr>
<td>651</td>
<td>Geographical subject heading</td>
</tr>
<tr>
<td>710</td>
<td>Added corporate author</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Technical Report Entry</th>
<th>Tag Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTH</td>
<td>Personal author(s)</td>
</tr>
<tr>
<td>CONN</td>
<td>Contract number</td>
</tr>
<tr>
<td>CORP</td>
<td>Corporate author</td>
</tr>
<tr>
<td>CTTL</td>
<td>Classified title</td>
</tr>
<tr>
<td>TITL</td>
<td>Unclassified title</td>
</tr>
<tr>
<td>DATE</td>
<td>Date entered</td>
</tr>
<tr>
<td>DESC</td>
<td>Descriptors</td>
</tr>
<tr>
<td>IDEN</td>
<td>Identifiers</td>
</tr>
</tbody>
</table>
Stopwords

Words in the following list are typically defined as stopwords.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>AN</td>
</tr>
<tr>
<td>AS</td>
<td>AT</td>
</tr>
<tr>
<td>BE</td>
<td>BUT</td>
</tr>
<tr>
<td>BY</td>
<td>DO</td>
</tr>
<tr>
<td>FOR</td>
<td>IF</td>
</tr>
<tr>
<td>IN</td>
<td>IT</td>
</tr>
<tr>
<td>OF</td>
<td>ON</td>
</tr>
<tr>
<td>THE</td>
<td>TO</td>
</tr>
</tbody>
</table>

For example, if you type *the book of lists* in the Title box, SirsiDynix Symphony locates items with the title, “Book Lists.”

If the search expression contains all stopwords, a browse list appears.

SirsiDynix Symphony reads stopwords as a “normal” word when you enclose them in double-quotation marks.

Substitution and Truncation

In SirsiDynix Symphony, the ? and $ symbols represent substitution and truncation. Use these symbols together or separately within or at the end of a term. To search these symbols as characters, enclose them in double quotes.

Substitution

Use the ? symbol as a substitute for a missing character in a search term, usually when you are unsure of a spelling or when you want to find two forms of one word. For example:

*wom?n* retrieves “woman” or “women”

*theat??* retrieves “theatre” and “theater”

Truncation

Truncation is unlimited character substitution. Use the $ symbol to truncate search terms. You can also use it to represent a single character, many characters, or no characters. If you follow the $ symbol with a number, SirsiDynix Symphony limits the number of characters matched. When more than one term in a search expression is truncated, each term
is searched for all variations. When truncated words produce too many variations to search, a browse list is retrieved. For example:

**cook$** retrieves “cook,” “cooks,” “cooking,” and "cookbook"

**dos$sky** retrieves “Dostoyevsky” and “Dostoevsky”

**Searching Numbers in a List**

To search for individual numbers in a list, type a space between each number. SirsiDynix Symphony searches numbers separated by commas as if the numbers were not separated.

For example, SirsiDynix Symphony searches 1,2,3,4,5 as a single term, but SirsiDynix Symphony searches 1 2 3 4 5 as 1 SAME 2 SAME 3 SAME 4 SAME 5.

SirsiDynix Symphony searches 5000 and 5,000 as the same term.

**Searching Special Characters**

When searching characters with diacritics, usually you just drop the diacritic mark and type the base letter. For example, to search for **muñoz**, simply type **munoz**. There are some exceptions that we will discuss in the next section.

**Transliterated Characters**

The following table contains transliterated characters and the replacement characters to use when searching a term containing a transliterated character.

<table>
<thead>
<tr>
<th>Special Transliterated Character Name</th>
<th>Replacement Character</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polish L (uppercase)</td>
<td>L</td>
</tr>
<tr>
<td>Polish l (lowercase)</td>
<td>l</td>
</tr>
<tr>
<td>Scandinavian O (uppercase)</td>
<td>O</td>
</tr>
<tr>
<td>Scandinavian o (lowercase)</td>
<td>o</td>
</tr>
<tr>
<td>Icelandic thorn (uppercase)</td>
<td>B</td>
</tr>
<tr>
<td>Icelandic thorn (lowercase)</td>
<td>b</td>
</tr>
<tr>
<td>D with crossbar (uppercase)</td>
<td>D</td>
</tr>
<tr>
<td>d with crossbar (lowercase)</td>
<td>d</td>
</tr>
<tr>
<td>digraph AE (uppercase)</td>
<td>AE</td>
</tr>
<tr>
<td>digraph ae (lowercase)</td>
<td>ae</td>
</tr>
<tr>
<td>ligature OE (uppercase)</td>
<td>OE</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>ligature oe (lowercase)</td>
<td>oe</td>
</tr>
<tr>
<td>O-hook (uppercase)</td>
<td>O</td>
</tr>
<tr>
<td>O-hook (lowercase)</td>
<td>o</td>
</tr>
<tr>
<td>U-hook (uppercase)</td>
<td>U</td>
</tr>
<tr>
<td>u-hook (lowercase)</td>
<td>u</td>
</tr>
<tr>
<td>musical flat</td>
<td>b</td>
</tr>
</tbody>
</table>

**Punctuation**

When you include the punctuation marks listed below in a search expression, SirsiDynix Symphony either:

- Replaces the punctuation marks with spaces
- Searches variations of the search expression containing the punctuation
- Ignores the punctuation marks

**Periods**

SirsiDynix Symphony searches periods based on how this punctuation mark displays in the search expression. If the period does not mark the end of a sentence or if the period is not used as a decimal mark within a numeral, SirsiDynix Symphony replaces the periods with spaces. If the period is used as a decimal mark, it is not replaced with a space.

For example, the title Vacationland U.S. A. is searched as:

- title => VACATIONLAND U S A

The title 98.6: a novel is searched as:

- title => 98.6 NOVEL

**Commas**

SirsiDynix Symphony also replaces commas within a search expression with a space.

For example, the title Goodbye, Columbus and Five Short Stories is searched as:

- title => Goodbye Columbus Five Short Stories
Hyphens

Search expressions containing hyphens are searched with the hyphen included. A search without the hyphen displays words both with and without the hyphen.

For example, the title Camp-Fire Girls is searched as:

- title => Camp-fire Girls

Only titles that include a hyphen between camp and fire will display. To broaden the search to include the phrase Camp Fire with and without the hyphen, use the following search:

- title => Camp Fire Girls

Circumflex (^)

SirsiDynix Symphony ignores the circumflex in search expressions. The circumflex is used internally as a special character, and it cannot be supported as a literal character;

Miscellaneous Symbols

The following table contains additional special characters.

The characters do not affect searching. Some of the characters are replaced by a space and some are ignored.

<table>
<thead>
<tr>
<th>Punctuation</th>
<th>Punctuation Mark</th>
<th>Replaced With</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accent</td>
<td>,</td>
<td>space</td>
</tr>
<tr>
<td>Ampersand</td>
<td>&amp;</td>
<td>ignored</td>
</tr>
<tr>
<td>Apostrophe or Single Quotation Mark</td>
<td>’</td>
<td>ignored</td>
</tr>
<tr>
<td>Asterisk</td>
<td>*</td>
<td>space</td>
</tr>
<tr>
<td>At (each) sign</td>
<td>@</td>
<td>space</td>
</tr>
<tr>
<td>Back slash</td>
<td>\</td>
<td>ignored</td>
</tr>
<tr>
<td>Brackets</td>
<td>[ ]</td>
<td>space</td>
</tr>
<tr>
<td>Colon</td>
<td>:</td>
<td>space</td>
</tr>
<tr>
<td>Exclamation point</td>
<td>!</td>
<td>space</td>
</tr>
<tr>
<td>Symbol</td>
<td>Representation</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Forward slash</td>
<td>/</td>
<td>space</td>
</tr>
<tr>
<td>Number sign (pound sign, musical sharp)</td>
<td>#</td>
<td>space</td>
</tr>
<tr>
<td>Percent sign</td>
<td>%</td>
<td>space</td>
</tr>
<tr>
<td>Plus</td>
<td>+</td>
<td>space</td>
</tr>
<tr>
<td>Semicolon</td>
<td>;</td>
<td>space</td>
</tr>
<tr>
<td>Tilde</td>
<td>~</td>
<td>space</td>
</tr>
<tr>
<td>Underscore</td>
<td>_</td>
<td>space</td>
</tr>
</tbody>
</table>